
   

 

Creating Accessible Documents Guide 

Last Revised: July 14, 2023 

 

The purpose of this guide is to provide a list of steps for making Microsoft Word® documents 

and Adobe® PDF files accessible. This guide lists steps for improving document accessibility. 

Refer to other training resources for more specific details regarding a particular aspect of 

document accessibility. 

 

Making Word documents and PDFs accessible is important as more individuals are able to 

access these files using assistive technology. Additionally, document accessibility helps ensure 

508 compliance. 

 

How to Use This Guide 

 

This guide features headings that provide information regarding various components of 

document accessibility. Quickly find the component you want to learn about by navigating to the 

corresponding heading. 

 

Additional Training Resources 

 

• How to Make an Accessible Document in Microsoft Word Training Videos 

• Microsoft Word and Best Practices Certification Course 

 

Microsoft Word 

 

File Name and Saving Document 

 

• Give the document a descriptive name that easily identifies it. 

• Save your document in .docx (Word Document) format.  
 

Headings and Document Organization 

 

Headings are used to organize a document into different sections. Each section should have a 

heading that describes it. Headings are organized into different levels. 

• Heading 1 (H1): The title of the entire document. 

o A document should only have one H1. 

• Heading 2 (H2): The title of each section within a document. 

o Every section within your document should have an H2. 

o You can add subsections within a section, but they will need to be at the next heading 

level. 

• Heading 3 (H3): A subsection within a section. 

• Heading 4 (H4): A subsection within a subsection within a section. 

• Heading 5 (H5): A subsection within a subsection within a subsection within a section. 

https://www.section508.gov/create/documents/training-videos/
https://training.section508.gov/508-training/courses/ms-word-best-practices/story.html
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• Heading 6 (H6): A subsection within a subsection within a subsection within a subsection 

within a section. 

 

Adding Headings to a Word Document 

• You can add headings into a document either via the ribbon or a key command. 

o Ribbon: Select the text you would like to make into a heading. Then go to the Home tab 

in the ribbon and find the Styles section. Select the heading level that needs to be applied. 

A heading will be added to the document. 

o Key Command: You can toggle through heading levels by pressing Alt + Shift + Left or 

Right Arrow. 

▪ Pressing Alt + Shift + Left Arrow will apply the previously used heading level 

beginning with H1. 

▪ Pressing Alt + Shift + Right Arrow will apply the next heading level beginning with 

H2 and onwards up to H6. 

▪ The key commands can be used to add headings before typing text or after text has 

been written. Select the text and then press the key commands to make a heading. 

 

Creating Lists 

 

Lists are used to organize information. Best practices are below. 

• Do not create a list by using symbols found on your keyboard such as hyphens, stars, dashes, 

etc. 

• Use the built-in lists feature in Word to add bulleted, numbered, and multilevel lists. 

o Add lists to a document by going to the Home tab within the ribbon and select the type of 

list that is needed in the Paragraph section. 

 

Using Columns and Reading Order 
 

Columns can help structure a document. Best practices are below. 

• Do not manually create columns with spaces and the Enter key. 

• Always use the built-in Columns feature. 

o Access the Columns feature by navigating to the Layout tab of the ribbon. 

o Select Columns within the Page Setup section. 

o Choose the number of columns you’d like to add to the document. 

• Using the built-in Columns feature improves the reading order for individuals using assistive 

technology, such as screen readers, as text will be read in the correct sequence. 

 

Tables 
 

There are three types of tables that can be placed into a document. 

• Layout Tables 

o Type of table using cells to lay out and format images and text 

o Does not require row and column headers 

o Can be made accessible in Word 

o Table must be placed in line with text 

• Simple Data Tables 
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o Type of table where row and column headers are necessary to understand information 

within a cell 

o Requires row and column headers; header row must be labeled 

o Does not have multilevel headings and merged cells 

o Can be made accessible in Word 

o Table must be placed in line with text 

 

• Complex Data Tables 

o A type of table that features multilevel headers and merged cells as well as row and 

column headers 

o Requires row and column headers; header row must be labeled 

o Has multilevel headings and merged cells 

o Cannot be made accessible in Word 

o Should be created another application that supports accessible complex data tables 

 

Best practices for inserting tables are below. 

• Only use tables when truly necessary. Other methods of communicating information, such as 

using a list, may eliminate accessibility challenges. 

• Always ensure rows and columns are clearly labeled. 

• Do not create or insert multilevel data tables in Word documents. 

• Do not insert an image of a table, as it is better to create the table instead. 

 

Insert tables into a Word document by doing the following: 

• Navigate to the Insert tab of the ribbon. 

• Select Table in the Tables section. 

• Select the number of rows and columns the table requires. Remember to consider row and 

column headers if inserting a simple data table. 

• Place the table in line with text to ensure the proper reading order. 

 

Distinct Languages 
 

Any change in language must be noted in a Word document for individuals using assistive 

technology such as screen readers. 

 

Set distinct languages by following the steps below. 

• Select the text that is in another language. 

• Navigate to the Review tab of the ribbon. 

• Select Language. 

• Select Set Proofing Language. 

• Select the language that the selected text is written in and press OK to set a distinct language. 

• The above steps should be followed each time a distinct language is used in a Word 

document. 

• There is no need to set distinct languages for proper names, technical terms, or foreign 

terminology that are commonly used in English. 
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Links 

 

Links should feature descriptive text to reduce ambiguity for screen reader users. Best practices 

for inserting links into a Word document are below. 

• Type out descriptive text that identifies the link instead of pasting the link address into a 

document. 

• Select the descriptive text that identifies the link. 

• Either press Control + K or right click and select Link. 

• Paste the link into the edit field labeled Address and press Enter. 

• Do not paste a link without descriptive text, as assistive technology may not provide context 

on where the link takes a user. 

 

Headers, Footers, and Watermarks 

 

Assistive technology, such as screen readers, do not automatically read information in headers, 

footers, and watermarks. Information in headers, footers, and watermarks should be duplicated 

near the start of the corresponding content area. Only vital information needs to be reproduced. 

Only use headers, footers, and watermarks if necessary and try to not place vital information in 

these locations. 

 

Images and Objects 
 

Images and objects are not made accessible by default. Steps to make images and objects 

accessible are below. 

• Ensure all images and objects are positioned in line with text to align elements in the proper 

reading order. 

• Add descriptive text to images and objects for screen reader users. There are three methods 

for adding descriptive text. 

o Alternative Text: A one-to-two sentence description of the important elements of the 

image, including the function and purpose. Alt text descriptions should be no more than 

250 words. 

o Captions: Text near the image or object that describes its important aspects including the 

function and purpose. 

o Information in Surrounding Text or Appendix: Text describing an image or object’s 

function and purpose. 

• How to Add Alt Text 

o Right click on the image that needs alt text. 

o Select View Alt Text. 

o Write the alt text in the dialogue box that appears. 

• How to Write Alt Text 

o Alt Text should only be one to two sentences and no more 250 words. 

o It should only describe the key functions and purpose. 

o It should include all text displayed in the image and object. 

o It should include “ ” for decorative images and objects. 

▪ Write the characters “(spacebar)” 
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Textboxes 
 

All textboxes must be placed in line with text, as screen readers can only read text within a 

textbox when aligned this way. Select the textbox to view alignment options and then select the 

in line with text option. 

 

Color and Sensory Characteristics in Word 
 

Color and sensory characteristics must be considered when making a Word document accessible. 

• Sensory characteristics include size, shape, and position. These sensory characteristics alone 

do not make a document accessible, as individuals with visual disabilities may not have 

access to this content. 

• If color is used to designate meaning (e.g., red means stop), add text explaining the meaning 

of color. 

• Ensure color has high contrast. 

• Text and backgrounds must also have high contrast. 

o Consider using a dark background with light text or a light background with dark text. 

 

Embedded Files 
 

Embedded files must be made accessible to allow equal access to content for all users. 

• Audio-only files must include an accurate and complete transcript. 

o A transcript is the complete text of what was said in the audio file. 

• Video-only files must include an accurate and complete text description. 

o A text description is a text version of what is being shown in the video. 

• Multimedia files containing audio and video and must be accompanied by synchronized 

captions and audio description. 

o Captions: Time synchronized text of what is said and descriptions for sound in 

multimedia files. 

o Audio Description: Time synchronized descriptions of what is being shown in a 

multimedia file. 

 

Accessibility Checker 
 

Use the built-in Accessibility Checker to review the document for any accessibility-related 

errors. 

• Access the Accessibility Checker by navigating to the Review tab of the ribbon. 

• Click on Check Accessibility in the Accessibility section. 

• Clicking on the arrow next to the Check Accessibility option will open a dropdown menu 

with additional options. 

Note that the Accessibility Checker may not notice all inaccessible aspects within a Word 

document, meaning that the author must also manually check the document to confirm it is free 

of inaccessible content. 
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PDFs 

 

Please review the items above regarding Microsoft Word prior to reading this section for PDF 

accessibility. 

 

Additional Training and Resources 

• PDF Accessibility Checklist 

• PDF Accessibility Training Videos 

 

Converting Documents to PDFs 
 

There are two ways to convert files to PDF format. 

• Convert scanned and non-scanned documents to PDF format using Adobe Acrobat DC. 

• Use the Adobe Acrobat plug-in in Microsoft Word to convert documents to PDF format. 

 

Converting non-Word Files to PDF 
 

Follow the steps below to convert documents that are not Microsoft Word files to PDF format. 

• Open Adobe Acrobat DC. 

• Navigate to File then select Create. 

• Then select PDF from File. 

• Select the non-Word document that needs to be converted to PDF format once the file 

selection dialogue box appears. 

• Select Open, and the document will now appear in Adobe Acrobat DC. 

• Review the accessibility of the PDF file with 

o Adobe’s Full Accessibility Checker Tool 

▪ Content, tags, order panes 

 

Converting Word Documents to PDF 
 

Follow the steps below to convert Microsoft Word documents to PDF format. 

• Do not use the Save As feature to convert documents to PDF format, as some accessibility 

elements may not transfer during the conversion process. 

• Follow all steps mentioned above in the Microsoft Word section to ensure document 

accessibility. 

• Select the Acrobat tab in the ribbon. 

o Ensure that the Acrobat plug-in has been installed in order to access this menu. 

o Use the instructions for non-Word documents if the Acrobat plug-in cannot be installed. 

• Navigate to Preferences. 

• Ensure the following checkboxes are selected. 

o View Adobe PDF Result 

o Prompt for Adobe PDF file name 

o Convert Document Information 

o Create Bookmarks 

o Add Links 

o Enable Accessibility and Reflow with tagged Adobe PDF 

https://www.section508.gov/create/pdfs/authoring-guides/
https://www.section508.gov/create/pdfs/training-videos/
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• Set PDF A Compliance to None 

• Select Advanced Settings. 

o Change Compatibility to Acrobat 8.0 (PDF 1.7) 

▪ This setting is important as it should ensure that the latest accessibility features are 

applied to the document once converted. 

• Select OK to save conversion settings. These settings will not change unless altered by a 

user. 

• Select Create PDF within the Acrobat tab of the ribbon. 

• Name the file once the dialogue box appears and click Save. 

• The converted PDF file will open in Adobe Acrobat DC. 

 

Converting Scanned Documents to PDF 
 

All accessible PDFs must contain renderable text, enabling assistive technology to access the 

document. Scanned documents may not always contain renderable text. Use the Content Pane to 

evaluate whether a scanned document contains renderable text by completing the following 

steps. 

• Navigate to View. 

• Hover over Show/Hide. 

• Hover over Navigation Panes. 

• Select Content. 

• Expand the Content Tree by pressing Shift + 8. 

• Examine the text that appears on the left and evaluating whether it matches the text in the 

Physical View of the PDF. 

• The PDF will not have renderable text if information regarding images and figures are the 

only items present in the Content Pane. 

 

Optical Character Recognition (OCR) will be necessary if renderable text is not present in the 

PDF. OCR requires a high-quality scanned document for optimal results. 

Access the built-in OCR tool by completing the following steps. 

• Navigate to Tools. 

• Select Enhance Scans. 

• Select Recognize Text, and then select In This File. 

• Select Settings within the Recognized Text toolbar. 

• Identify all pages that require OCR. 

• Set the document’s language to the appropriate option. 

• Set Output to Searchable Images. 

• Set Downsample. 

o Use 300 dpi for grayscale. 

o Use 600 dpi for color. 

• Select OK. 

• Select Recognize Text. 
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OCR may not render text correctly. Evaluate the quality of the OCR and make corrections as 

needed by completing the following steps. 

• Select Correct Recognized Text from the Recognize Text toolbar. 

• Only select Accept if the recognized text was correctly identified. 

• Type the correction in the Recognized As edit field. 

• Follow this sequence for the entirety of the PDF. 

 

Evaluate the quality of the OCR by exporting the PDF to Microsoft Word. Compare the two files 

and ensure they match. 

 

Minor edits can be made in Acrobat. Major edits should be made in Microsoft Word. 

 

View the steps below to make the OCR version of the PDF accessible. 

 

Testing PDFs for Accessibility 
 

View the PDF document properties including the following: 

• Descriptive file name 

• Contain PDF tags 

• Ability to copy content from the PDF 

• Specified language 

 

View document properties by navigating to File and then selecting Properties. Navigate to 

Description. 

• Add or confirm a descriptive file name in the Title edit field. 

• Navigate to the Initial View tab and look for Show and select Document Title 

o The above setting must be configured to ensure accessibility. 

• Navigate to the Description section and ensure that Tagged PDF is set to Yes. 

o The above setting is essential for PDF accessibility. 

• Navigate to the Security tab and ensure that Content Copying for Accessibility is set to 

Allowed. 

• Navigate to Advanced and ensure that the correct language is set for the PDF file under 

Language. 

o A PDF with multiple languages requires that a tag be used to indicate a language change. 

 

The Physical View elements include headings, lists, tables, figures, and form fields. Follow the 

steps below to access the Physical View in a PDF. 

• Navigate to View. 

• Navigate to Show/Hide. 

• Navigate to Navigation Panes. 

• Select Content, and a dialogue box will appear on the left side of the screen. 

• Expand the content tree by pressing Shift + 8, which will reveal all of the document’s 

contents. 

o OCR will be needed if a scanned document is being examined for accessibility. 
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Tags Structure Tree and Reading Order 

 

The PDF’s Tag Structure Tree must also be examined for accessibility, which provides 

information related to headers, paragraphs, lists, data, tables, figures, and form fields. The 

various document elements must correspond with the appropriate tag. All document elements 

must be tagged to ensure accessibility for assistive technology. 

 

Access the Tags Structure Tree by following these steps. 

• Navigate to View. 

• Navigate to Show/Hide. 

• Navigate to Navigation Panes. 

• Navigate to Tags. 

• Expand the Tags Structure Tree by pressing Shift + 8. 

 

Ensure that all document elements correspond with the proper tag in the Physical View. 

 

To examine the type of tag being used, do the following. 

• Right click on the Tag. 

• Select Properties. 

• The tag type will be displayed in the Type combo box. 

• Click on the tag type to change the tag if necessary. 

 

Review the PDF’s reading order for accessibility by returning to the Tags Structure Tree and 

ensuring document elements are placed in a logical reading order. Ensure that document 

elements are positioned in the way they should be read. Doing so may require the creator of the 

document to arrange the visual layout. 

 

The Logical Tab Order must also be examined if links and form fields, including text boxes and 

button controls, are found within the PDF. The Tab Order can be evaluated by pressing the Tab 

key, which will navigate the user through the various links and form field elements. Ensure that 

the screen focus navigates in the logical reading order. 

 

Alt Text 

 

All images and figures must contain alt text. Evaluate whether images and figures contain alt text 

by doing the following. 

• Navigate to Tools. 

• Navigate to Accessibility. 

• Navigate to Reading Order. 

• Check Show Tables and Figures. 

• Evaluate the alt text placed on images and figures. 

• Add alt text to images and figures by right clicking on images and figures marked as Figure. 

o Select Edit Alternative Text. 

o Type alt text and selecting OK. 
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Data Tables 

 

Ensure that all tables within the PDF meet the following requirements. 

• All tables must have a table tag. 

• All Row and Column header cells must be tagged as TH (Table Header). 

• Complex Data Tables must contain the proper scope and span. 

o Scope informs users which cells are row and column headers. 

o Span informs users of the number of rows and columns of data cells. 

• Do not use images to represent data tables. 

 

Simple Data Tables 

 

Make Simple Data Tables accessible by doing the following. 

• Navigate to a simple data table and open the Tags Structure Tree. 

• Click on the Selection Tool. 

• Select (highlight) the first data cell within the table. 

• Select Options in the Tags Structure Tree. 

• Select Find Tag from Selection. 

• Expand table tags and tag all table elements appropriately. 

o Table header tags must be used for row and column headers. 

o Table data tags must be used for all cells that are not row and column headers. 

 

Complex Data Tables 

 

Follow all steps above in the Simple Data Tables section in addition to the items listed below. 

• Evaluate the scope and span by opening the Reading Order Pane. 

• Select Options. 

• Select Show Reading Order Panel. 

• Select the Reading Order number associated with the complex data table. 

• Select Table Editor. 

• Right click on each row and column header cell. 

• Select Table Cell Properties. 

• Confirm that Scope is set to Row Header or Column Header. 

• Columns that also represent a row header require both of the above options to be selected. 

• Select (highlight) all data cells that expand across multiple rows and columns. 

• Right click on the cell. 

• Select Table Cell Properties. 

• Confirm that Span correctly identifies the number of rows, columns, and cell spans. 

 

Form Field Elements 

 

All form field elements must contain a tooltip and need to appear in the logical Tab Order. You 

can find and navigate to form field elements to by pressing Tab. 
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Form field elements include the following: 

• Edit fields 

• Radio buttons 

• Checkboxes 

• Combo boxes 

 

Review the tooltip for each Form Field element by hovering over each element. Ensure that the 

name of the proper element is displayed and that the proper Tab and Reading orders are 

followed. 

 

Links 

 

Links are made accessible within a PDF by ensuring they are uniquely identified with descriptive 

text instead of URLs and that they follow the logical Tab Order. Navigate to each link by 

pressing Tab, and evaluate them for accessibility. 

 

Images that appear as links must include alt text that state the purpose of the link. 

 

Color and Sensory Characteristics in PDFs 

 

Color and sensory characteristics must be considered to make a PDF accessible. 

• Sensory characteristics include size, shape, and position. These sensory characteristics alone 

do not make a PDF accessible, as individuals with visual disabilities may not have access to 

this content. 

• If color is used to designate meaning (e.g., red means stop), add text explaining the meaning 

of color. 

• Ensure color has high contrast. 

• Text and backgrounds must also have high contrast. 

o Consider using a dark background with light text or a light background with dark text. 

 

Accessibility Full Check Tool 

 

Run Acrobat’s Accessibility Full Check Tool to find errors. To access this feature, do the 

following. 

• Navigate to Tools. 

• Navigate to Accessibility. 

• Select Full Check. 

• Select the Select All button, ensuring the PDF will be checked for all aspects of accessibility. 

The Accessibility Full Check Tool may not provide information regarding all errors. Manual 

accessibility checks may need to be conducted to ensure full accessibility. 


